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ASCENDER - Next Year Payroll Process
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Revised: 02/01/2024

The purpose of this document is to guide you through the necessary steps to create next year's
payroll. This process includes updating tables and employee information, calculating salaries,
performing edits, and interfacing payroll to Budget. This process occurs in the next year and does
not interfere with the current year processing.

This document assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

| Some of the images and/or examples provided in this document are for informational
£ purposes only and may not completely represent your LEA’s process.

Prerequisites

Prerequisites:

Gather Beneficial Data:

@ This section is strictly for informational purposes.

Before performing the next year payroll process, review the following tables and gather the data that
will be beneficial while you are updating this information for the new school year.

Proposed/Approved Next Year Salary Schedule

Personnel > Tables > Salaries

Once a salary table is assigned to an employee on the Payroll > Maintenance > Staff Job/Pay Data >
Job Info tab, the table can be updated and salary calculations can be run for all affected employees
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eliminating the need to update the information for each individual employee.

Proposed/Approved Next Year Workday Calendars

Personnel > Tables > Workday Calendars > School Calendar

After receiving the upcoming approved school year calendars, you can create a calendar(s) to assist
with documenting employee workdays and holidays. It is helpful to plan future pay dates and payoff
dates for the next school year in advance.

Reference State Minimum Salary Schedule

Review the TEA Minimum Salary Schedules for changes effective with the new school year.

Accrual Calendar Information

Payroll > Tables > Accrual Calendars > Accrual Calendar

O Creating and assigning an accrual calendar to employees allows you to maintain the accrual
calculations throughout the school year. You can obtain workdays by month information from the
workday calendars.

O Be sure to keep the same accrual codes for each accrual calendar. This method allows for
consistency and eliminates the need to update the information for each individual employee.

O Accounting for the August EQY accrued days in the accrual calendar and using the EQY Payroll
Accruals process assists in properly accounting for accruals across the fiscal years.

Update Next Year Staffing Changes

When payroll opens for the next year, be sure to keep up with the following staffing updates:

e Resignations and new hires: Update the employee status as resignations and new hires are
approved to allow the appropriate budget amounts to be created and interfaced.

e Campus level changes: Update the job table and employment information as jobs move from
one campus to another.
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e Distribution changes: Update employee distributions based on budget changes.

* Update extra duty/stipend pay: Update the extra duty table to reflect changes and
payments. Also, update the balance on the Payroll > Maintenance > Staff Job/Pay Data > Pay
Info tab. The next year payroll budget calculations use the s-type extra duty remaining amount;
therefore, it is important to verify that these amounts have been updated.

¢ Update substitute pay: If substitute pay rates change, update the Personnel > Tables >
Salaries > Substitute tab, which is associated with entering employee substitute leave
transmittals.

Extract Third Party Administrator (benefits) Information

Payroll > Utilities > Employee Benefits Interface > Extract

Perform an extract to create the files containing deductions and demographic data to be sent to the
third-party vendor.

Only deduction codes that have an Extract Ded Cd (extract deduction code) on the Payroll > Tables
> Tax/Deduction > Deduction Code are extracted.

After the new premiums are updated by the third-party administrator and the file is returned, you can
import the updated file making the changes to the next year deductions in one step.

Payroll > Utilities > Employee Benefits Interface > Import Annual File

This utility imports the next year employee benefit choices via a file created by your third-party
vendor. Importing data decreases the amount of time it takes to enter individual employee data
changes.

Manage Employee Change Requests

O Create a form for next year employee change requests. This form assists with data entry and
provides documentation.

O Set a deadline for employee change requests prior to the end of the current school year to allow
time for clarification if needed.

O Update employee direct deposit information. Use caution when updating this information in the
next year frequency as the system will prompt you to update this information in the current year
frequency.

O If your LEA has not already done so, set up the EmployeePortal application. EmployeePortal allows
employees to submit demographic changes and payroll (W-4 and direct deposit) changes. LEA-defined
options determine what changes can be made by the employee and the necessary approvals.
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Before You Begin

Before you begin:
Things to Remember Prior to Beginning NYR Payroll

O Ensure open communication exists between the payroll office and business office.

» Verify that the Budget process is complete and the budget is open.
 Set potential deadlines for various presentations.

O Verify that you are logged on to the current pay frequency.

0 Remember: Next year calculations and distributions are validated to the new budget (N). Make
sure that the fiscal year on the distribution pages matches what is in the new budget (N). If it changes
during the process, perform a mass update.

Current and Next Year Shared Pages

The following pages are shared between the current year and next year. Use Caution
when updating these pages in the next year:

Personnel or Payroll > Tables > District HR Options
Personnel > Tables > Credential

Payroll > Tables > Tax/Deductions

Payroll > Tables > Bank Codes

Personnel > Maintenance > Staff Demo (all tabs)
Personnel > Maintenance > Employment Info

Reminders

e New employees must have a Unique ID. Create a Personnel record and copy it to NY Payroll to
ensure that they are included in the Unique ID Extract.

¢ Do not update years of service or leave until Service Records have been created. This usually
occurs between the June and July payrolls and is covered in the Service Record guide.

e Medicare On-Behalf is usually posted to the TRS website in late summer. In most cases, a
reminder is sent by your ESC so you can book actuals to Finance for the year and create a
budget for next year.

e Remember to update NY Payroll in Budget periodically to ensure that changes are updated. This
allows Budget to remain as current as possible.
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Extract IDs

Extract IDs can be used to group similar employees to allow for easier and more accurate mass
updates. For example, most 187-day teachers/aides have the same contract Begin and End Dates,
same Calendar Code, and the same Payoff Date, which may allow them to be grouped together by
extract ID making it easier to select that group of employees when performing Mass Updates.

To use extract IDs:
Personnel > Tables > Job/Contract > Extract ID

O Add or modify extract IDs.

JOB CODES CONTRACT CLASS

COMTRALCT TERM CONTRALT YEAR

EXTRACT ID

Extract |d Description

. | A | |187 TEACHERS/AIDES |
B [ B | [202 coacHes |
T [ C ]| [207 counsELORITECH ]
o D ] (182 careTERIA |
w ( E | (226 emPLOYEES |
¥ F ] (256 MAINTENANCE ]
'8 G | [220 SUP. SECRETARY ]
B [ n_ ) [imerrEs |
w [ i ] [277 pT cusTODIAN ]
( 5 ] [suss )

TERMIMNATIOM REASON

':; I These extract IDs must meet your LEA's criteria so it is important for the Payroll and
&  Personnel departments to communicate about the setup and use of extract IDs.

Personnel > Maintenance > Employment Info

O After extract IDs are established, assign or modify the extract IDs for each individual employee

record.
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Employes: | 000479 : APPLEGATE. CHRISTINA LEEANN : bty J .E SRy J

EMPLOVMENT INFO

Empleves Statut EleD'."Ed
Ermgdomemarn Dates Errgdirpmeet Tyt Firte g Irforn Ao
DOriginal Emp Duts Emptovmert TVRe: [ Hatr Time or mor )| Retrement Diste
Latest Re-Employ Date Sty Typst [ ] Pewree Emplayment Type [ -]
Termiration Date: 00- 000000 gty Chaakticd D Take Retinoe Surchaege l:l
Tesmwaruytion Fieason [—.,l Ve Round i MY Take Retinee Surcharpe I:l
Elgpbis for He: e D Extract ID: I-‘-'.:r'll-“.-f""'w-*:'r"- V]
Paecont Doy Employed 1 Bschelors W

Payroll > Utilities > Mass Update

O After extract IDs are assigned as needed, select the applicable Extract ID and run the necessary
mass update for a specified group of employees. Extract IDs can also assist in sorting and filtering
report data.

Wgsr & Frogquency |
Parameters
Py Statu ;__I
@ cove (Dinaceee (o Primaey Compurs. [ ) Poemome [ i
Py Camrgnts [aa ] ey LF Monthly NYH ~|
Py Tupe (2= v Contract Bogen Dats: | v] .
: : . ; = .
Jeb Codde E v Contract frd Dot | = IL wtract 10 A 187 TEACHERS/AIDES ¥} I
Aceryal Code - i .
Cod L Contract Monshe :] Emplovecber: | J§
Pmonce [ ]
DEDUCTIONS.  LEAVE EMPLOYEE EXTRADUTY JOBCODE  SALAAT CALOCULATION
Retet = i l -]

g

T 3 m

AL L

000300000

0000080006880

000 |

Personnel > Reports > User Created Reports

If your LEA uses extract IDs to group employees for mass updates, generate a user-created report to
verify that extract IDs are correctly assigned to employees.

If extract IDs are missing or need to be changed, you can manually update individual employee
records using the Personnel > Maintenance > Employment Info page.
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Next Year Payroll Process

1. Verify August EQY payroll accruals.
Verify August EOY payroll accruals

This step applies to LEAs that included non-accrued employees in the EQY payroll accrual
process.

O If ASCENDER is used for the EQY payroll accruals, verify that the accrual reversal process was
completed in September 2024.

Log on to Finance file ID 4.

File ID: 4

Finance > Inquiry > General Ledger Inquiry > General Ledger Inquiry

File ID: 4 Account Period: 05
Fund Func Oby Soby Org  reeeeremmresanes Progesrmrassesaanes
Accouns Code: (155 )1 ()1 (@55 (o8 (o ()8 ()1 ()4 )i | |
-
il Rirveros’ Rz Rrvarus/
Type _Numter Date Pas P Dairiergon Apgrrigriaton [Encumbranis Exparuifure Baarca
195 11 8119 00 007 4 11 0 00 TEACHER SALARIES. GEM INSTRUCT
* Bagnning 000 0.00 Q.00 000

G MOVEBU 0801-2023 09 OPENMNG ENTRY 416,942 00 .00

G PE0SIE 08142020 09 SEP- PAYROLL DISTREUTION 39.716 36

Gl PRI 011303 10 OCT - PAYROLL DESTRIBUTION 42630 21

GJ PSS 11132023 11 NOV - PAYROLL DISTREBUTION M08 M

GJ  PEIZIS 12133020 12 DEC - PAYROLL DISTRIBUTION 33,746,850

GJ  PEOTIZ 01102024 01 JAN: PAYROLL DISTRIBUTION 317224

GJ PRI 0213300 0 FEB - PAYROLL DISTRIBUTION 37 583,63

GJ  PSO3IS  O0-12-3004 03 MAR- PAYROLL DISTRIBUTION 3193785

Gl PRI Q412304 04 APR - PAYROLL DISTRIBUTION 995102

GJ  PE0SIE  OF10-20 05 MAY - PAYROLL DISTREBUTION 4181808

GJ  PE0EN4  O612-200 06 JUN- PAYROLL DISTRIBUTION 14,406 72

GJ PEOMS 07123034 07 JUL- PAYROLL NSTRIBUTION 1451978

GJ BNAL 07-18-2024 OF JUL - PAYROLL DISTRIBUTION 531344

Gi  PEOMIS 0T B30 OF AUL- PAYROLL DISTRIBUTION -7 42000

Gl TCOWR O 8-20M 07 AL - PAYROLL DISTRIBUTION -2 963 00

GJ  ACHAVA O7-18-2004 07 JUL- PAYROLL DISTRIBUTION 58N

Gl PSOTIE 0813304 08 JUL- PAYROLL ISTRIBUTION 13.110.91

G PEOSTE G- 14-p00d 08 AU . BAYEOL] DISTEBLTION 4§71 &3

| Gl EOVADC 05312024 03 AUG PAYROLL ACCRU DISTRIBUTI 45501 14 |
Ending 418,54 00 .00 41157163 -5.368 37
-

o Type 199.11.6119 or 199.00.2161 in the Fund, Function, and Object Code fields.

o Leave all other fields masked (Xs).

o Click Retrieve.

o Verify that “Payroll Accrual” (or an LEA-defined description) with a positive expenditure
amount was posted (typically in August 2024).
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Log on to Finance file ID C.

File ID: C

Finance > Inquiry > General Ledger Inquiry > General Ledger Inquiry

GENERAL LEDGER INQUIRY GEMERAL LEDGER ACCOUNT SUMMARY

m Processad D Current, Pericd: F9 m Maxt Pericd: 10

Show Datails  Report will display Transaction Details

EMPLOYEE DISTRIBUTION LEST INQUIRY  OVER EXPENDED ACCOUNT SUMMARY

includa soft encumbrances whan st Excluode Objects 61XX include nactive Accounts|
@ h POs wxist [ Exclisde Objects 610X [ A

Fomgl Fuig Oy Soby Org

s o0 (55t () ) (5 () (! ()¢ ()¢ (&)

Frog

28 “»
Dt Run: Detal Traraactons for Expendiure ACcounts
Cnty Dist: 150 Pageclol 4
Processed [ Curent (03) B teat (100 B 188 11 6119 00 000 x A0 X A Fils D C
Est Revanus' Rizd Revsnios’
Type Number Diaite Par PsasonDeacription Appropriabion Encumbrances Expandturs Balarce
199 11 B1M5 00 OM 4 11 0 00 SALARESTEACHERPROFESSIDNALS
= Baginning 000 a0 o 1]
Gl MR L8 DEeume FuTE SESEER 0 1Tl
I G REVACC 05052128 08 AUGPAYROLL ACCRU DISTRIBUTI H1.760.37
[cYR i = ;45!5'1!"
Gl PeIN0 W OCT - BRYROLL DISTRIBUTION 7400527
= Ending 29505200 oo 55900106 535951 54

o Type 199.11.6119 or 199.00.2161 in the Fund, Function, and Object Code fields.

o Leave all other fields masked (Xs).
o Click Retrieve.

o Verify that “August Payroll Accru” (or an LEA-defined description) reversal entry with a
negative expenditure amount was posted (typically in September 2024).

O If ASCENDER is not used for the EQY payroll accruals (days worked in August), there is no
computer journal entry. Verify that the manual JV entries were posted for EQY payroll accruals.

O If a reversal entry is not displayed, use the Payroll > Payroll Processing > EOY Payroll

Accruals page to complete the process.
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Year; C Frequency: 6

ACCRUAL TABLE DECREMENT RUN CALCULATIONS ACCRUAL REPORTS CREATE GEMERAL JOURMAL INTERFACE TO FINANCE POST TO MASTER REVERSAL FOR NON-ACCRUAL MASS DELETE

Fila 1D: Ravarsal Interface Transaction Date:
Accounting Period
N Narer

(®) Post to Current Acct Periad: 10

() Prost to Mot Acct Period: 11

D F 08312004 08-26- 2024 08-25- 2024 09-10-2004

2. Clear next year tables.
Clear next year tables
Payroll > Next Year > Copy CYR Tables to NYR > Clear Next Year Tables

Log on to the current pay frequency.

CLEAR NEXT YEAR TABLES COPY CURRENT YEAR TABLES

[ Clear EOY Accrual Data Only [ ] Clear NY Payroll Budget Only

Mo Rows Accrual Calendar
Extra Duty Pay
Haurly / Daily Salary
Job Code

Local Annual Salary
Midpoint Salary
School Calendar

State Minimum Salary
Substitute Salary

Workers' Compensation Rates

Employee Bank Record

Employee Deductions

Employee Extra Duty
Employee Job

Employee Pay

fild |

gogooooooooooooooooag

Employee Pay Distribution
ECQH Accrual Calendar

EQY Accrual Data

EOY Accrual Fund Decrement
NY Payroll Budget

If the next year payroll process was used last year and those records were not cleared, use the
following steps to clear the records.

U Do not select the Clear EOY Accrual Data Only and Clear NY Payroll Budget Only
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fields. The EQY accrual data and next year payroll budget data is cleared whether or not these
fields are selected.

O Move all of the tables from the left side to the right side of the page.

O Click Execute. All existing employees are deleted from the next year payroll files and a clean
work file is now available allowing you to begin building next year data.

Note: This process clears all tables in all pay frequencies; therefore, it is only necessary to
perform this process in one pay frequency even if your LEA has multiple pay frequencies.

This process can be verified by logging on to the next year pay frequency and running the
Personnel > Reports > Personnel Reports > HRS1000 - Roster of Personnel Report for active
and inactive employees. The report results should be blank.

. Copy current year tables.
Copy current year tables
Payroll > Next Year > Copy CYR Tables to NYR > Copy Current Year Tables

Log on to the current pay frequency.

CLEAR NEXT YEAR TABLES COPY CURRENT YEAR TABLES

. I Execute ] [ Select All Tables ]
Accrual Calendar

Extra Duty Pay

Hourly / Daily Salary

Job Code

Midpoint Salary

School Calendar

State Minimum Salary

Substitute Salary

l
[
(
|
Local Annual Salary (
[
[
|
|
l

_,__,_____,__
[N IS I CS B N I N Y S I S [ CS B S T N

Workers' Compensation Rates

O Click Select All Tables to select all current year tables to be copied to the next year. It is
recommended that all tables are copied so that you have immediate access to any selected
table.

o This process copies all tables (except the school calendar table) for all next year pay
frequencies, regardless of the pay frequency to which you are logged on.
o To copy the school calendar, log on to each pay frequency to do so. The school calendar
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is not copied, only the calendar code and the calendar description are copied.
O Click Execute. A separate preview report is displayed for each selected table.

O Click Process on each report page to copy the table. Or, click Cancel not to copy the table. A
message is displayed indicating that the tables were successfully copied. Click OK.

4. Copy current year staff to next year.
Copy current year staff to next year
Payroll > Next Year > Copy CYR Staff to NYR

Log on to the current pay frequency.

Brecte | R J '
Parameters
Pay Status
| @ Active Oinactive ) Both | Primary Campus: [ Al v | Payolf Date [:]
Pay Campus: [ Au M ] Frequency: & MOMNTHLY CYR w ]
Ipdf Type: [ E Exclude Substitute v ]I Contract Begin Date: | v]  Satary Cancspt (A1l v)
Job Code: All v | Contract End Date: [ ~ | Extract I0 [ w ]
Accrusl Code All wl Contract Months: B Employee MNir ':]!
Prior ¥ Emp Date: | 00-00-0000
Options
| I:-;ll.rju Employees with Termination Date I
D Inactivate Records when Creating WY Tables
[ Preview changes
Mext Year's Funding Code D
Murmber of Remaining Deductions [:]

Copy the employees from the current year payroll to the next year payroll. If you have multiple
pay frequencies, complete this task in all pay frequencies.

Reminder: Be aware of where the budget is in terms of the fiscal year.

What happens?

A complete copy of the current employee record is moved to the next year. Employees can be
inactivated or activated when copying to the next year and those with termination dates can
also be included in the copy process. When copying, you can change the fiscal year in
distribution as well as the remaining deductions in the employee master record. If you update
the number of remaining deductions, all deductions on the employee Deduction tab are
updated to the designated default value. Be careful of deductions that should not be activated
for the next year and those that the number of remaining deductions should be different from
the default value and perform any necessary cleanup. The Payroll > Utilities > Mass Update
tabs can be used to modify remaining payments for deduction codes.
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If this process is performed multiple times for employees without deleting their NYR records, the
system either updates or inserts distribution records from CYR to NYR and cleanup may be
necessary.

Employees in the next year must be active to extract distribution information to Budget. If you
do not activate employees when copying to next year, you can activate them when you perform
a mass update.

O Under Pay Status, select Active to copy only active employees.
O In the Pay Type field, select E Exclude Substitute.
O Under Options:

o It is recommended to select Include Employees with Termination Date to copy active
employees with a termination date on the Personnel > Maintenance > Employment Info
tab.

o Do not select Inactivate Records when Creating NY Tables.

o In the Next Year's Funding Code field, type the fiscal year to be used when updating
the distribution account code fiscal year in the next year employee master distribution
records.

Leave blank if the distribution account code fiscal year in the next year employee master
distribution record is to remain the same as the current fiscal year until the next year
budget is in place. Then, use the Mass Update utility to update to the correct fiscal year.

o |t is recommended that the Number of Remaining Deductions is left blank to copy
deductions with the number of remaining deductions as they exist in the current pay
frequency.

O Click Execute. If the process is successful, a preview report is displayed. Review the
employee list to verify that the correct data was copied to the next year records. Also, review
the total employee count at the end of the report.

O Click Process to accept the changes and continue. A message is displayed indicating that
the process was completed successfully. In addition, a list of the database record tables that
were copied is displayed. Click OK.

O Click Cancel to return to the Copy CYR Staff to NYR page without making the changes.

Jj'
‘ ) Prior to continuing this process, log on to the next year pay frequency.

5. Verify employee data.
Generate reports to verify employee data
Generate the following reports to assist in verifying employee data.

o Personnel > Reports > Personnel Reports > HRS1000 - Roster of Personnel - If an
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employee was not copied over to the next year, run the Copy CYR Staff to NYR utility
again for only the single employee.

[ Preview ] [ POF ] [ csv ] [ Clear Options ]
Personnel Reports HRS1000 - Roster of Personnel
HRS1000 - Roster of Personnel - \
HES1050 - Emplovee Birthday List e
HRS1100 - Emploves Verification Report Parameter Description Value
HRS1200 - Federal EEOC Report -
HRS1250 - Employes Data Listing Sort by Alpha (A). Pay Campus (C), Primary Campus (P)
HRS1400 - Teacher Service Record Print Address Primary (F), Alternate (A)
HRS1450 - Emplovec Mailing Labels
HRS1500 - Emploves Education Report Select Restriction Local (L), Public (P), orNo restrictions (N) (N |
HRS1550 - New Hire Report 5
HR51600 - Cerification Report Include Primary Job Code? (Y/N)
HRS1650 - Employes Salary Information :
HRS1700 - Social Secyrity Nymber Verification Pay Status Active [A), inactive (I). or blank for ALL [:]
HES1750 - Teacher Incentive Allotment Designation Regort Pay Type 1-4, Exclude Subs (E), or blank for ALL :
Select Pay Campus(es), or blank for ALL [: i
Select Primary Campusies), or blank for ALL : i
Seleet Extract ID(s). o blank for ALL : :
Seleet Employee(s), or blank for ALL .
Setec Frcuency C—
Date Run: Personnal Roster Report Program: HRS1000
Cnity Dist: I1SD Page: 10of an
Freguency: F
Emp Nbr Employee Nama Employee Address City, State, Zip Primary Campus Telephone
Job Code
00DOOR  ACHIMON. AARON ROXANNE 36911 CR412 Alama City. TX 25457 107 - 107 Schodl (555) 586-0643
0178 - WWE REG ED TEACHER
000025 ALFORD, ADRIENNE JOHN 25263 BASTROP STREET Alama City. TX 28178 007 - 007 Schodl
0080 - MHS CTE TEACHER
000040 AMOS, ALEXANDRIA M 124378 FM 381 Alamao City. TX 27968 905 - 905 Schod (555) 586-1933
(0662 - EXEC DIR OF OPERATIONS

o Payroll or Personnel > Reports > Personnel Reports > HR51250 - Employee Data Listing -
This report can be used to verify deduction information and is available in Personnel or
Payroll. Run the report with only the Include Reports parameter set to Deductions. A
user created report can be created to only include deduction information. It can be sorted
by deduction code and remaining payments.
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[ Preview ] [ PDF I :- csv | Clear Options I
Personnel Reports HRS1250 - Employee Data Listing
HRS1100 - Employves Verification Report -
HES1250 - Employes Data Listing
BS1650 - Emploves S ; Parameter Description Value
Sortby Alpha (A). Pay Campus (C). Primary Campus (P) )
it Reports Setect Fom s :
Include SSN on Report? [Y/M) [r l
Include Number of Days Employed /in Contract on Report? (YN) 1 S
From Last Name |3 letters) l D Personnel
To Last Name (3 Letters) l 8 Payroll
Job
Pay Status Active (4). Inactive (1), or blank for ALL l D TRS
Pay Type 1-4, or blank for ALL l D Calendar ¥TD
Select Pay Campusfes). or blank for ALL ( O schoot 11O
D Leave
Select Primary Campus(es). or blank for ALL I Deduction
Select Extract ID(s). or blank for ALL [ (] Distributicn
Select € 5), or blank for ALL ] €] Pusponskiatty
ect Employee(s). or o 0] Permi
E-mail Subject [
E-mail Message l
l 0K ‘ I Cancel
From Pay Date (MMODYYYY). or blank for ALL C
To Pay Date (MMDDYYYY), or blank for ALL l |
@ 4 P |
Date Run: Employee Data Listing Program: HRS1250
Cnty Dist: ISD Page: 1of 1
Frequency. F
Emp Nbr: 000006  Emp Name: ACHIMON, AARON ROXANNE PEBLEY
Payroll Name & Primary Address Former Name & Alternate Address Primary Campus: 107 - 107 Scheool
Last  ACHIMON Last Payroll Campus: 107 - 107 Scheol
First:  AARON First: Info Restrict A Gender: F - Female
Middle: ROXANNE PEBLEY Middle Rastrict Public:. A Marital Stat: M - Married
Title Gen: Title: Gen: Local Area 1 Birth Date:  07-12-1360
Street: 36911CR412 Street Local Area 2 LastChg:  03-13-201%
City/St: Alame City, TX City/St Drivers Lics: 93658985 T™®
ZipCd: 25497 ZpCd DL Expir Date: Deceased: N
Country. TRS Beg. Dt 11-01-2000 SSN 256-66-3799
Phone: (555)586-0643 Cell ( ) BusPh () Bus BExt Citizen: Y
\wk E-mail: Hm E-mail Hispanic/Latino [ Black/African American O
Supplemental Acgess Asian (] Amenican Indian/Alaskan Native [
OB hite B Native Hawaian Other Pacific sl )
Emergency Contact Relation Bilingual
Phone: Ext
Emergency Notes
Deductions
Emplr  Remain Cafe Emplr TEA
Deduction Code Net Amount Contib  Pymts Refund 125 Factor Factor
001 - ADDITIONAL 300.00 00 99 N N 1 1
025 - ACTIVE CARE PRIMARY (11] 51400 99 N Y 1 1
054 - GROUP (DISTRICT PAID 00 & 9 N N 1 1
100 - TPA EXTRACT FILE 00 00 0 N N 1 1

o Payroll or Personnel > Reports > Personnel Reports > HRS1100 - Employee Verification
Report - This report provides detailed employee data such as employment dates, salary,
address, and other information for reference or to verify recent input and processing.
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’ Preview ] ’ PDF ] ’ [Ty ] ’ Clear Oplions ]
Personnel Reports HRS1100 - Employes Verification Report:
HES1100 - Employes Verilication Report
HRE1250 - Employee Data Listi P
HRS1650 - Emgloyee Salary Infommation Parameter Description Valle
Sort oy Alh A). Py Compus €. Pray Cas
Select Restriction Local (L), Public (P), or No restrictions. (N)
Pimary Job (P, or blank for ALL )
Pay Status Active (&), Inactive (1), or blank for ALL
Pay Type 1-4, Exclude Subs [E), or blank for SLL
Salect Pay Carmpus|es), er blank lor ALL 1
Select Primary Campusies), or blank for ALL :} i
Satect Extract IDfs), o blank for ALL 1 :
Select Employes(s), er blank for ALL A
Date Run: Employes Verificalion Report Program: HRS1100
Gty Dist: 1SD Page:3of 9
Frequency: &
Emp Nbr  Employee Name Emp Date Emp Status Pay Status Job Code
Sex Address Term Date  Term Reason Cred Yr Svc Pay Campus Primary Campus
City State Zip Pro Yrs Exp MNon-Pro Yrs Exp ExtLvBeg  Payoff Date “%Day Empl St Step GRDILVL /Sched
Birth Date Telephone In Dist In Dist Ext Lv End TRS Beg Date  Annual Sal Pay Type Pay Rate
000060 SMITH, BARBARA GALE 08-16-2001 2 - Active auxillary per 1 = Active 0428 - PHYSICAL EDUCATION
F PO BOX 555 (m] 999 - District Wide 735 - CAFETERIA
ANYWHERE TX 76809 o 14 08-25-2022 100% SPA / 114
03-01-1962 o 14 03-01-2009 33,702.00 2 2,808.50
000082 SMITH, BECKY R 07-01-2004 1 - Active professional 1 - Active 0115 - BUSINESS MANAGER
F 2810 SNICKERS ROAD O 750 - BUSINESS 750 - BUSINESS
ANYWHERE TX 75661 17 o1 06-24-2022 100% 17 ! !
09-11-1952 17 1] 09-29-2004 116,000.00 1 9,666.67
000131 SMITH, BRENDA K 08-11-2005 2 - Active auillary per 1 - Active 0721 - CAFETERIA FULL TIME
F 5854 LIBERTY BELL RD O 735 - CAFETERIA T35 - CAFETERIA
ANYWHERE TX 758657 o 33 08-25-2022 100% CAF / i
01-24-1950 o 14 08-15-2006 15,346.80 3 14.21
000104 SMITH, CAROLYN M 08-09-2004 1 - Active professional 1 - Active 0638 - JR & SR HIGH TEACHER
F 42956 ROSEBEOROUGH RD O 002 - ANWHERE HIGH 002 - ANWHERE HIGH SCHOOL|
ANYWHERE TX 75672 18 [} 08-25-2022 100% 17 TR1 { 18/

o Personnel > Reports > Payroll Information Reports > HRS6550 - Employee Extra Duty
Report - The report lists all employees with extra duty codes on the Pay Info tab. The
report can be sorted by name, campus, or extra duty code. The Include Distribution
Account Codes parameter includes S-type distributions for the selected employees.

e J[ v [ o || sextens |

Payroll Information Reports HRSE550 - Employee Extra Duty Report
HRES132 m| L ata Listin -
HRS1450 - Employes Mailing Labels

S 1660 - Emploves Salary Indorrmation

HRS52 04 Form:
HRSSIES - 1095-C Forms
HESE300 - Emploves Permit Data Inelude Distribution Account Cades? (1M
HES5350 - Emploves Responsibaity Data
HRSEA00 - Salary Verification Roport Pay Status Active (A}, Inactive (1), or blank for ALL
HESEAG0 - Health Insurance Coverage
HESES00 - Campys Intormation Pay Type L-4, Exclude Subs (E), or blank for ALL
HRES6550 - Employes Extra Duty Report
HESEE00 - Campus improvement Plan Exip FTE Report Sclect Pay Campusies). or blank for ALL

HESE700 - Health Insurance Status Regort Select Primary Campus(es), or Blank for ALL : i

Parameter Description Value

Sort by Alpha [A). Pay Campus (), Primary Campus (P}, Extra Duty Code (E)

HRESE T AL 1 YTD Regort
Sclect Extra Duty Code(s). or blank for ALL

Sedect Efmnplayes{s), or blamk far ALL
Page Broak by Extra Duty Code (Y/N) (Reguined when selecting Sart by Extra Duty Coda)

Select Frequency
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Date Run: Employee Exira Duty Report Program: HRSG6550
Cnity Dist: ISD Page: 1of B
Frequency: F
Extra Duty Code Typ Amount Remain Amt Remain Pymts
Emp Nbr Employse Name Account Code Job Acct Amit Acct Percent  Grant E Perf Pay Activity Code
000006 ACHIMON, AARON ROXANMNE 04 G 1.000.00 1] 0
000025 ALFORD, ADRIEMNE JOHN 03 G 3.000.00 oo 0
04 G 1.000.00 ] 0
09 G 3.500.00 00 0
28 G 7.700.00 oo 0
42 G 1.000.00 ] 0
Total for ALFORD, ADRIENNE JOHN 16,200.00 .00

6. Update school calendar.

Create calendars

Personnel > Tables > Workday Calendars > School Calendar

Only complete this step if it is applicable to your LEA. All LEAs must create a TR calendar.

cted Calen

whar Code: TR TRS - Frequency: F

L

Create school calendars to accommodate the varied number of days employees work at the
LEA. The calendar is used on the Payroll > Maintenance > Staff Job/Pay Data > Job Info tab to
calculate the Number of Days Employed field if the beginning and ending contract dates are
entered. Additionally, using a calendar can provide an easier way to manage payoffs and verify
your accrual days.

Notes:

o Calendars tied to a numeric frequency (e.g., 6) are used for current year.

o Calendars tied to an alpha frequency (e.g., F) are used for next year. Use the
spyglass to create or edit calendars as needed.
o You can copy calendars that begin in the same month. Example: If you create the
10-month calendar beginning in August for teachers for 187 days, you can copy the
calendar to the Food Service and Bus Driving calendar codes, and then edit them to
reflect the differences such as begin dates and holidays.

2025/12/05 19:57
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O Create calendars with the same calendar code as the current year to avoid having to update
the calendar code on the individual employee's job info record.

[ Select the calendar to be updated.

2 ; T2 [l'cE.-' DAYS TEACHERS ]
D i 13 [13.‘" DAYS STAFF ]
fl::j F TR [._.1!5 ]

Start Year [YYYY)

[
Start Month [MM) [[‘.'3 ]

[ set Catendar ’i"III

Start Year |Type the starting calendar year in the YYYY format.
Start Month Type the starting calendar month in the MM format (e.g., 07 for July).

O Click Set Calendar to display the calendar. The calendar is rearranged to begin with the
entered starting month.

Workdays By Month
Aagiist L

I

It is recommended that you build the calendar with the greatest number of days
ol worked first, and then use the Copy School Calendar tab to build other calendars
© by making modifications to the original.

/2. IMPORTANT:

o For TRS purposes, a TR calendar with a calendar code of TR must be created
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for all available workdays beginning 09/01. (TIP: If 9/01 falls on a weekend
day, select the first working day of the month.) The TR calendar is used to
populate the number of days worked on the RP report for employees who are

E | E not assigned to a school calendar

= o For TRS purposes, ASCENDER submits retirees' contract days one month at a
time. This allows maintenance on the reporting of half time or full time from
month to month on retirees.

7. (Optional) Update accrual calendars.
(Optional) Update accrual calendars
Payroll > Tables > Accrual Calendars > Accrual Calendar
This step is for LEAs that perform monthly accruals.

Create accrual calendars to accommodate the varied number of days employees work at the
LEA. The calendar is used on the Payroll > Maintenance > Staff Job/Pay Data > Job Info tab to
calculate the Accrual Rate when the calendar code is entered in the Accrual Info section.

| S Year: N Frequency: F

Delete Details Acgrual Code Total Days Worked

-

A Do
[= 0.0
H 0.0
N 0o

14.00]

20.00)

DDDD

22.00]

17.00)

15.00]

Verify that the calendar code reflects the actual number of days the employee will work for the
new school year; otherwise, the salary amount that should accrue over the school year will be
incorrect.

o You can use the school calendar created in the previous step to get the actual workdays
by month.

o If you have not set up the budget for the 2025-2026 school year, you can only enter pay
dates through the 2025 calendar year. If the budget is set up for the 2025-2026 school
year, you can enter 2026 pay dates in these fields.

Notes:

o This table can be updated after the move to current. All pay dates should be entered
even if zero days are accrued (e.g., summer months).

o Most districts only accrue 10-month employees. If that is true for you, each code
should begin with August 31 and show the number of days that group of employees
will work in August. Add 12 more lines and enter the true/regular Pay Dates. Enter the
days employees work in the month associated with each pay date.

o Typically, July and August (and sometimes June) will show the pay date and zero
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days, but they still must be included.
o Dates used (with the exception of August 31) must match the Pay Dates that will be
built in the Pay Date Table.

8. Update staff credentials.
Update employee credentials
Personnel > Tables > Credential

Update the Credential tabs as needed. This information is used to maintain teacher credentials,
is usually done by the personnel department and does not affect salary calculations.

The Credential tabs are shared between the current year and next year records; therefore,
changes to the current year records are effective in the next year records, and vice versa.

Note: The Teaching Specialization tab is used to report Pre-K teachers for Class Roster so if
there have been changes, you can make those updates now in anticipation of the
submission.

MAJOR / MINOR COLLEGE CODE CERTIFICATION TYPE SPECIALTY AREA TEACHING SPECIALIZATION SERVICE RECORD NOTES

o

Personnel > Tables > Credential > Major/Minor

Personnel > Tables > Credential > College Code
Personnel > Tables > Credential > Certification Type
Personnel > Tables > Credential > Specialty Area
Personnel > Tables > Credential > Teaching Specialization
Personnel > Tables > Credential > Service Record Notes

[¢]

[¢]

[¢]

[¢]

o

9. Update next year salary table.
Update next year salary tables
Personnel > Tables > Salaries NYR

Update the following next year salary tables to reflect any changes to the salary schedules
(anticipated or known).

These tables are not shared between the current year and next year records.
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LOCAL ANMUAL HOURLY/DAILY EXTRA DUTY STATE MIN SUBSTITUTE MIDPOINT WORKERS' COMP

Personnel > Tables > Salaries NYR > Local Annual

This tab is the most commonly used. You can make mass updates by percent or dollar amount,
or by employee. To see a change before saving the record, enter the change and click Default.
The original annual amount is displayed in the Annual Amt column, the percent or dollar is
increased, and the New Amount is displayed. Click Save. If decreasing a salary, enter a
negative percent or dollar amount.

On the Personnel > Tables > Job/Contract > Job Codes tab, this salary concept can be attached
to the applicable job(s). When the job is selected on the Job Info tab, the system populates the
Base Annual field automatically in the Daily Rate section on that page and can calculate the
daily rate based on the number of days employed. In addition, when the Mass Update Salary
Calculations feature is used, the system uses this table to extract the correct salary information,
perform calculations, and populate many fields on the Job Info tab.

LOCAL ANNUAL  HOURLYDAILY EXTRADUTY  STATEMIN  SUBSTITUTE  MIDPOINT  WORKERS' COMP

Raconds Modithy Salary

) [ T— [ Default | Print
Pay -,__-_-._a__ﬁ [: (8) By Percont ﬁ_ru,_,.,._ 3 )

Pay St
3y Step D By Dollar st

Dhelite Pay Grade Pay Step Max Doys Emploved  Locsl Sched  Annisl Armd 3 Increade Blirww &4 i vt
BT a0 [ oo BN 17 (MR ] 1437000 [ 0.00] [ 1437000]
8 [ aw [ ot | [ 1w | ] 177000 ( 0.00) [ 1ar7ooo)
B [ aw [ o | EETE § || [ 0.00] [ 1s17000)
B [Tawo [ e ] [ ] | | [ 0.00) [ 1557000)
W [ aw [ o ) [ 1 | ] 1587000 [ 0.00) [ 1s87000)

[ e [ o5 ] [ 1 ] | | 147000 [ 0.00] [ 1s370000]
] [ww ) [ e ] [ ] | ]| st [ 0.00] [ isrroo0)
@ [Taw J[ o ) [ i | | ] im0 ( 0.00) [ 17.17000)
W [ aw [ o ) [ 1 | | ] 17s7000 [ 0.00) [ 1757000)
[ aw [ e ] [ 1 ] | ] 1787000 [ 0.00] [ 17970100
8 [Taw [ _u I . 1 || | 0.00] [ 1srroo0)
[ a0 [ 1z | [ w7 ] | ] 917000 [ 000) [ 1917000
B [ aw J[ = [ 1w ] | i | ooa] [ 1957000
[ aw ) [ e ] [ ] | | 1997000 [ e.00) [ 1997000
(1] [ aw ]| 1 il EETER || | | .00 [ 20370.00]

Personnel > Tables > Salaries NYR > Hourly/Daily
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The Hourly/Daily and Midpoint tabs can be updated in the same way if used by your LEA.

Siree

LOCAL ANNUAL  HOURLYDWAAY  EXTRADUTY  STATEMIN  SUBSTITUTE  MIDPOINT  WORKERS COMP

Fsconds ity Salary
. [ flirtraee l Dvetani ] l P
Pay E-ul:-: (® By Percern Amgunt w
Pary Shep 3
m O By Dollar s
{Z) Fram State bn

Colots oy Grads Ea Sign braPerDay BmeTios oo Sched B Trog ExtChimibiry  Amount % bcrougs i Amour
| s iareml o | I ~] [ epo.o] QRS Y oooo (R 12830] I
B (o J ) Cem ] Mt ] v] | soos] 12830 | o) (o) |
B [Twor J [ [ oo | Heww ] [ w] [ @oop] ieES0 [ 0,000 [ 17s30]
B w1 [ 1 [ sea ] Metr | IR v [ gogn)  L2EI0 [ 0.000) [ 12830]
B | [Twr [ 1z [ s || My 1 w] [ spoo] PR [ 0,000 [ 13E30]
B [wor ]| 3 [ soo | Hewty | ][ v [ goon|  L2EN0 [ 0.000) [ 128m)
B e | [ 3« [ seo | el | g w] [ apop) 42830 [ 0.000] [ 12830
B [w1 J[ 158 [ 800 ] How | ][ v [ goon)|  LIEN [ 0000 [ 128m]
B [Tem | [ 1 ][ see ] e | 11 v soop] 42830 [ 0.000] | 12630]
[Two1 ) [ ) [ 800 | MHew J ][ v [ soop)  1EE30 [ 0.000] [ 12830]
B v [ ][ soo | Hesr | ][ « [ spop]  i2EaR | vooo] [ 1zes)

LOCAL ANNUAL  HOURLMDAILY  EXTRADUTY  STATEMIN - SUBSTITUTE  MIDPOINT  WORKERS COMP

Records Modify Salary
| ——
Pay Acty:  [al (®) By Percort A*nnuﬂ %
wholly Sepfan | (O By Dollar &mt
3
Delete Loge Descrigtion Agcoust Code Agtivity Wholly 360 Exp 373
"" [[] [Tecrnoocy aine ] [[r99-11-6129.00-001-%-31-0-] 5 [0 Base Salary v F[Hre v [¥ account used in 458 ()
@ [COUNSELOR MASTER ][00 A0 H--8] 3 [79 Other Supplemental w]  [WMo w] (¥ Account used in ASB
& [coaching ] [19536-611900-001%91-0-] §  [02 LI Athlstics v] [Hhcw] [¥Accountmedinace
o [Ma SUPPLENENT ] [oea-soocoon-Roe0dx] 3 [20 Base Salary w| [MbMow] [¥ Account used in ASE f
o [cHEER sPonsoR ] [r2e-3s-e11901-001-%x-91-0-] 3 [18UL Cwbeiactviies w]  [MMo w]  [¥ Account used in 258
& [arT sTIPEND ] [199-36-6119.00-000-%-99-0-] ; [05BandorOmnesa  w]| [NMow] ¥ Account used in ASE o
[ [ATHLETIC DRECT. ]  [199-35-6119.00-001-%-91-0-] 3  [02 WL Athietics w]  [mmHew]  [¥ account used in ASE
T [MATH/SCIENCE SUP ] [R-soooi - Ror-ii-s] 3 [79 Other Supplemental ] [MMo w] ¥ decount used in ASB
@ [BAND STIPEND ] [ 00000-00CK-0-0] 3 [05BandorOrchestra w|  [MHow] [V Account wsed in A5H
] [sTasR CORE ] [ESS-a0000dn-inena0ex] ¢ [16 UL Cubsiactivites w]  [M Mo w] [V Account used in ASE
w [11] [sramsnsmpenc ] [289-11-6119.00-001-%300x-] §  [80Base Satary w] [MHow] [¥ Account used in A58
& [REC. STIFEND ] [eecooccoooxxx-kaoex] 3 20 Base Salary w| [Mrew]  [¥ Account wsed in ASE
-
(1] [rearBoGK | [ - oo K-xx-8] 3 [79 Other Supplemental ] [MNe w] (¥ Account used in 858 "
L] L]
A

J2v) )

2025/12/05 19:57 21 ASCENDER - Next Year Payroll Process


https://help.ascendertx.com/business/lib/exe/detail.php/general/quickview/nextyearpayroll/personnel_hourly_daily_tab.jpg?id=academy%3Abusiness_payroll_nextyearpayrollprocess
https://help.ascendertx.com/business/doku.php/personnel/tables/salaries/extraduty
https://help.ascendertx.com/business/lib/exe/detail.php/general/quickview/nextyearpayroll/personnel_extra_duty_tab.jpg?id=academy%3Abusiness_payroll_nextyearpayrollprocess

Business

Personnel > Tables > Salaries NYR > State Min

This tab is updated via a file upload when applicable. These instructions are sent separately
with the file as needed.

Personnel > Tables > Salaries NYR > Substitute

This tab can be manually updated as needed.

LOCAL ANNUAL  HOURLDYDBELY EXTRA DUTY STATE A SUBSTITUTE MIDPOINT WORKERS COMP

Reconds Mockty Salary [ [

I:}I-\. Dsller it

Dulete Sl Ty Sub Descrgin

¥
g

-
£
S S S el .

L+ |
ST
= 1]
]
]
]

[ B

CERTIFIED TEACHER SUBSTITUTE [

CERTIFIED TEACHER SUBSTITUTE |’ T

Personnel > Tables > Salaries NYR > Midpoint

Payroll > Tables > Tax/Deductions > Workers' Comp

10. Update TRS rates table.
Update TRS rates table
Payroll > Tables > Tax/Deductions > TRS Rates

Update the TRS rates.

6 CAUTION: Be sure to retrieve the 2026 school year data prior to updating this tab.

IMPORTANT: Be sure to visit the TRS website:

& https://www.trs.texas.gov/Pages/re_contribution_rates.aspx to obtain the updated
rates for the next school year, and then return to this table to update the new
rates.
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Sehool Tear: | Fiotrse

CAUTION: Be sure to type the new
school year (2026) and click Retrieve
before entering the update rates.

l Delete J [ inls J

TRS Rate Member Retirernent Contribation: 8.25%
0
TRS Insurance Member Care Contribution:
0.65%] Employer Paid:
District Rate State Contribution: D
B8.250%
TRS Care Rate Federal TRS Care:

1.25%

TRS Care Empls Contrib  Bf TRS Care Contribution: 3

TRS IRS SaLar-,- Cap:

TRS Mon-OASDI Rate  Public Education Employer Contribution [PEEC):

2
gl || [5| |
gl [# &| |

O To create a new TRS rates record, type the new year (2026) and click Retrieve. A message is
displayed indicating that the new record is populated based on the prior year's (2025) TRS rates
record, click Save to retain the record.

O Complete the applicable fields. This information is used when performing calculations and
extracts to Budget.

11. Update deduction code table.
Update deduction code table

Payroll > Tables > Tax/Deductions > Deduction Code

] Year: C

EXEMPTIONS  INCOME TAX FICATAX UNEMPLOYMENT  TRSRATES  ANMUITY RATES  WORKERS COMP  DEDUCTION €D

Vendat MameDart Key Vendor Mo Extract Ded Gl W] Heglth Care

| ] O
| —) O
| (— ] | — O

O Update the deduction codes. The Deduction Code tab is shared between the current year and
next year records; therefore, changes to the current year records are effective in the next year
records, and vice versa.

12. Update job code table.
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Update job code table
Personnel > Tables > Job/Contract NYR > Job Codes
Add or update job codes as needed.

The job codes table is not shared between the current year and next year records.

e i e e |
J

JOB CODES

Delete Job Code lob Description EEQC Code Agcount Code Salary Concept Increa
[ oooo | [ceneric D v [ - | 3 [Auseasnnual satary table  +|
[(0001 ] [HIGH SCHOOL TEACHER | v] (- .- ---- ] 3 [AUseannuatsalarytanle v ]
[ ooz | [TEACHER/COACH N vl [-- - ---- ] § [AUseannualsalary table |

O Select the appropriate Salary Concept for each job.

O (Optional) Update the distribution Account Code fields.

Notes:

o In the FTE Hrs field, type the appropriate full-time hours for each job code. Effective
September 2017, the scheduled weekly hours are used by TRS reporting.

o You can assign accrual codes, Workers’ Comp codes, and FTE hours to lessen the
workload when completing tabs for new employees.

13. TRS Information

Verify TRS fields
Payroll > Reports > User Created Reports > HR Report

Generate a user-created report to verify that the following TRS fields are accurate for all
employees. You can use the sort/filter options to assist in the verification process. If corrections
are needed, use the corresponding pages to make changes.

TRS Reporting Requirements

o ALL employees are reported.
o Retired employees are only reported on the ER record.
o A contract Begin and End Date is required for ALL employees.
Required Information ASCENDER Business Page
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14,

15.

The FTE Hours (full-time equivalent) is required for the
ED record if 30 hours or more.

Personnel > Tables > Job/Contract >
Job Codes

The Days Worked or scheduled is required for the RP
record. This data is retrieved from either the school
calendar or TR calendar.

Personnel > Tables > Workday
Calendars

The Employment Type is required for the ED record.

Personnel > Maintenance >
Employment Info

The TRS Status (TRS membership eligibility flag) is
required for the ED record.

Payroll > Maintenance > Staff Job/Pay
Data > Pay Info

A TRS Member Pos (position) Code is required for all
employees (including substitutes).

The Wkly Hrs. Sched (hours scheduled) is required for
the RP record.

Payroll > Maintenance > Staff Job/Pay
Data > Job Info

The Retiree Employment Type is required for the ER
record.

Personnel > Maintenance >
Employment Info

Update staff data.

Update staff demographic data.
Update staff demographic data

Personnel > Maintenance > Staff Demo > Demographic

[ Add new employees or update existing employees. Refer to the ASCENDER - New Employee
Setup guide for additional information about adding new employees.

The Staff Demo information is shared between the current year and next year records;
therefore, changes to the current year records are effective in the next year records and vice

Versa.
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Employec: (00000 : ADAMS, ADEME. ] [ Retricve ] [ Directary ] [ 4ictel Eman ] [ Ciacumants ]

DEMOGRAPHIC INFORMATION CREDENTIALS WERIFICATION INSEURANCE SERVICE RECORD RESPONSIBILITY

SRIDSSN: 110262035 TerssUnique St 0 [ ) Lot Change: 06112008
P o ) Ce | ) = ) 9 )
S 2 ] [ ) [ -

e e - —

e
Maiting [ | Fosoas i | [t | = %) B - () |
mm 1 | ] [ 2l e
gt ( ][ ] [ ]

Travel Commute Distance:

Remember: All employees must have a TX Unique ID number. The TX Unique ID number can
be extracted on the Personnel > Utilities > Texas Unique Staff ID Interface > Staff ID Export

tab.

STAFF ID EXPORT STAFF ID IMPORT

School Year:

From: 2024 Tac

[ Exacute

O Save the file and forward it to your District PEIMS Coordinator to be processed.
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STAFF ID EXPORT STAFF ID IMPORT

Import File:

File Name Browse.. l [

16. Update employment info data.
Update employment info data
Personnel
Add or update employee information on the following tabs:

o Personnel > Maintenance > Employment Info - This tab is shared between the current
year and next year records; therefore, changes to the current year records are effective in
the next year records and vice versa.

O Select the NY Take Retiree Surcharge field to include the retiree surcharge when the
Extract Payroll to Budget process is performed.

Note: If service records have not been created, do not update data such as the
Percent Day Employed, Years Experience and Grade(s) Taught fields for
existing employees.

Terminated Employees

It is best practice to not only update the Termination Date and Reason but, if applicable,
update the Auxiliary Role ID and Paraprofessional Certification End Date.
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Personnel > Maintenance > Staff Demo > Responsibility

In addition, update the End Date on the employee's responsibility record.

Sawve

Employee: l ] [ Retrieve ] I Directory l [ Decuments !

DEMOGRAPHIC INFORMATION CREDENTIALS VERIFICATION INSURANCE SERVICE RECORD RESPONSIBILITY

Delete Details Year Campus Staff Classification

-
1
o

School Year for PEIMS Codes: 2025

Job Code: (0300 SECONDARY SCHOOL COUNSELOR _ v] Staff Service: (55007000 - Guidance And Counseling Services ) §
- 52D St A e 2
Co-opfsSALEA: [ | Pop Served: [01 Regular Students ~)
Staff Classification: (D08 - School Counselor ]i  Maonthly Minutes: ]
ESC/SSA: [School District Employee v) # of Students:
Begin Date: [08-13-2007]
crsne
Payroll

o Pay Info - This tab is not shared between the current year and next year records.
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O Make the necessary changes to the extra duty supplements and verify the changes
using the Payroll > Reports > Payroll Information Reports > HRS6400 - Salary Verification
Report.

O Updates to the extra duty table do not automatically update the extra duty data on the
Pay Info tab.

* Click Yes to update both the current year and next year records.
* Click No to update only the next year records.

This also occurs when changes are made in the current year records and next year
records exist.

o Job Info - This tab is not shared between the current year and next year records.

O For new employees, a generic job is displayed on the Job Info tab and this job can be
modified as needed. The following fields must be completed prior to saving:
* Primary Campus
* % Assigned
# of Days Empld
TRS Member Position
Begin Date
End Date

Notes:

o The following data should be entered before performing automatic salary calculations:
* Pay Grade
= Step
= Sched (if applicable)
= Max Days
= State Step
= State Min Days
= TRS Year - This field should be selected if the employee has a nonstandard
contract.
» Accrual Codes
= W/C Code
= State Minimum Salary % Assigned - Verify this field for employees whose # of
Days Employed field does not match the State Min Days field on the Job Info tab
for the primary job and adjust accordingly.
= Distribution information
o Distributions - This tab is not shared between the current year and next year records.

O If a contract amount is not entered on the Job Info tab, no amount or percentage is
required before saving the record. If the account code does not exist in Budget, it cannot
be selected from the account code drop-down list.

O A distribution code must exist for each job to be updated with salary calculations. When
calculations are performed, amounts are updated based on the existing distribution
percentages.
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O Verify Expense 373 designations for applicable employees who are subject to Stat Min
calculations.

o Deductions - This tab is not shared between the current year and next year records.

Exception: When changes to an existing employee's deduction information is saved, a
message is displayed asking if the current year records should be updated.

If the Remain Pymts field is set to 99, it will not decrement each time a payroll is
processed.

Be sure to add an Emplr Contrib (Employer Contribution) amount for vacancies/new
employees to avoid an understated budget.

Update the garnishment amounts as there may be changes to the salary amounts for the
upcoming year and the garnishment amounts are based on salary percentages.

Click Yes to update both the current year and next year records.
Click No to update only the next year records.

This also occurs when changes are made in the current year records and next year
records exist.

* Click Yes to update both the current year and next year records.
* Click No to update only the current year records.

17. Perform salary calculations.
Mass update salary calculations
Payroll > Utilities > Mass Update > Salary Calculation

Perform salary calculations if you are using salary tables. This tab is used to automatically
calculate salaries for active employees (pay status 1) that are linked to the salary tables. You
can quickly calculate salaries and automatically update important fields in the employee record.

®tciv Orcie O C vl —
2 ¥) (Frmoarmoa <]
- | g
L ) L > wpt: [ anruzal yalary |
A | ) Cha | | i ,_,]
DEDAUCTIONS LEAVE EMPLOYEE DXTRADUTY  JOBCODE  SALARY CALCULATION
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TIP: Salary calculations should not be done multiple times for an employee using
&  the midpoint table.

A report provides a listing of errors prior to completing the process. Clear all errors and perform
the calculations as often as necessary. All errors should be cleared before continuing. If
employee errors are encountered, the listed employees are not updated. If the employee has
multiple jobs and one of those jobs does not have all or part of the salary table information
selected on the Job Info tab, errors are displayed and updates are not processed. When
calculations are performed on one concept and the employee has multiple concepts, errors are
displayed if any of the other concepts are incomplete and updates are not processed.

The system automatically uses the new contract amount and distributes it among the
employees' master distribution records based on the existing percentage. The new amount
displays regardless of the option selected in the Distributions Built by Amt % field on the
Payroll or Personnel > Tables > District HR Options. Manual modifications may be necessary to
employees' salary distribution codes, amounts, and/or percentages after performing salary
calculations.

O The following fields must be completed on the Job Info tab for pay type 1, 2, and 3
employees:

o Pay Grade

o Step

o Max Days - If the Max Days field is not populated, salary calculations will only process if
the field is not linked to the Annual Salary Concept. If the field is linked to the Annual
Salary Concept, this field must be populated to run salary calculations.

o Begin Date

o End Date

o The OVTM Rate field and the # of Days Employed field are calculated when the OVTM
flag and Calendar Code fields are populated on the Job Info tab.

o |If the State Step field is populated on the Job Info tab, the amount from the state
minimum salary table is entered in the State Min Salary field.

CAUTION: The State Min Salary field is calculated by multiplying either the
____ State Min Days or the # of Days Employed by the appropriate daily rate from
0 the state minimum salary table for all pay types that have state min. The %
Assigned field in the State Info section on the Job Info tab is also considered in
this calculation. The State Min Salary field should be checked closely and
manually updated, if necessary, after performing salary calculations.

o If an employee has an extra duty account type G on the Pay Info tab, it is added to the
Total field for the contract on the primary job.

o If an employee has a business allowance account type T or B amount with remaining
payments and/or an extra duty account type S amount with remaining payments and
distribution codes totaling 100% exists in the master distribution record for the account
type, the appropriate distribution records are updated.
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o If the # of Annual Payments and Contract Total fields are greater than zero, the Pay
Rate field is calculated by dividing the Contract Total by the # of Annual Payments.
If the # of Annual Payments and/or Contract Total are not populated, the Pay Rate is
not calculated.

o If the # of Days Empld and Contract Total fields are greater than zero, the Daily Rate
of Pay field is calculated by dividing the Contract Total by the # of Days Employed. If
the # of Days Employed and/or Contract Total are not populated, the Daily Rate of
Pay is not calculated.

o Other fields that are updated on the Job Info tab are:

= Accrual Rate - If the accrual code exists and the # of Days Empld and Contract
Total fields are greater than zero, the Accrual Rate field is calculated by dividing
the Contract Total by the # of Days Employed. The amount is rounded to three
decimal places.

= Contract Total and Balance

¢ Pay type 3 employee salaries are calculated based on the hourly/daily or
midpoint salary table information. If the local annual table is used, errors are
displayed when performing mass salary calculations.

e When using the hourly/daily salary schedule, calculations are based on the
Hrs Per Day field x the Amount field from the salary table x the # of Days
Employed field from the Job Info tab. The resulting amount populates the
Contract Total and Balance fields on the Job Info tab.

e When using the midpoint salary schedule, calculations are based on the
Midpoint field x the Amount field from the salary table x the # of Days
Employed field from the Job Info tab. The resulting amount populates the
Contract Total and Balance fields on the Job Info tab.

* If the # of Days Employed field is not populated, the Contract Total and
Balance fields are not calculated.

o If not performing mass salary calculations for hourly employees, manually update the
Contract Total on the Job Info tab and distribution information. This salary information is
extracted to Budget and used for PEIMS reporting.

o On the Job Info tab, there is a Calculate button, salary calculations can be done for an
individual rather than doing salary calculations in Mass Update for groups of employees.
The Calculate button on the Job Info tab will render the same results as doing the Mass
Update salary calculations.

o The Automatically Compute fields on the District HR Options page assist in manually
updating employees. By using this feature, the pay rate, daily rate, dock rate, accrual
rate, and overtime rate can all be automatically calculated when the annual contract and
days employed are entered on the Job Info tab.

Midpoint Calculation Examples

- ¢ : 2 Max Percent Fay Mid Percent Pa Max Inc/Dec Mid Inc/Diac
Pay Grade Pay Type Minimum  Maximum  Midpoint ¥ ¥ Hour
Incrgase Increase Amount Armount

1 Contracted employes 203.680 305.530 254 605 [

2.00 _.] 0.000 5.092 a0

) |
ntracted emploves 224040 336070 280055 | 0000) | 2000) 0,000 6601  BOD
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18. Verify salary calculations.
Verify salary calculations
Select and run the applicable reports to verify the salary calculations:

o Personnel > Reports > Personnel Reports > HRS1000 - Roster of Personnel - This report
provides a list of employees by pay campus. This is a good report to give to principals and
directors to verify employees assigned to their campus or department without sharing
pay information.

o Payroll or Personnel > Reports > HR Reports > Personnel Reports > HRS1250 - Employee
Data Listing - This report provides detailed information about demographics, salary,
TRS/Calendar/School YTD, leave, deductions, and account distribution codes.

o Payroll > Reports > Payroll Information Reports > HRS6050 - Contract Balance Variance
Report - This report will print exceptions for contracted (pay type 1) and non-contract
(pay type 2) employees when the contract balance does not equal the Pay Rate times
the # of Remaining Payments.

o Payroll > Reports > Payroll Information Reports > HRS6150 - Employee Payroll Listing -
This report provides detailed information about pay status, campus code, pay type,
marital status, number exemptions, months/days in contract, annual contract amount,
monthly/daily rate of pay, and the first distribution line from the master distribution
record.

o Payroll > Reports > Payroll Information Reports > HRS6400 - Salary Verification Report -
This report can be used to verify that next year salary calculations have been correctly
run before copying next year to current year.

o Payroll > Reports > Payroll Information Reports > HRS6000 - Account Code Comparison -
The report is an error listing. For current year, the report identifies account codes in the
payroll process and verifies that these account codes exist in Finance. If a code entered in
the payroll process is not located in the chart of accounts, the account number, social
security number, and name of the employee are printed on the report. For next year, the
report identifies account codes on the Budget Data page of the Budget application.

o Personnel > Reports > Payroll Information Reports > HRS6550 - Employee Extra Duty
Report - The report lists all employees with extra duty codes on the Pay Info tab. Users
can sort the listing by name, campus, or extra duty code. The Include Distribution
Account Codes parameter allows the user to include S-type distributions for those
employees selected.

o Payroll or Personnel > Reports > Payroll Information Reports > HRS6650 - CYR/NRY Salary
Comparison - This report provides a salary comparison for employees with pay type 1 and
pay type 2 jobs. The report indicates employee information and job information for both
the current year and next year to allow an easy comparison of salaries between the data.

o Payroll or Personnel > Reports > User Created Reports > HR Report - Run user created
reports as defined by the user.

19. Use Addendum sheets to verify data.
Use Addendum sheets to verify data

Payroll > Utilities > Payroll Simulation > Addendum

Use the Addendum created when using the Payroll Simulation utility to verify data as it lists all
jobs separately, as well as business allowances, extra duty, etc.
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Only active employees (pay status 1) are considered in this process. The Addendum sheets can
be used to explain pay to employees and as a contract support document for applicable
employees to sign & date.

Personnel > Reports > Payroll Information Reports > Employee Salary Information

o If this report is generated from next year payroll files, leave information is excluded.
o If this report is generated from current year payroll files, leave information is included.

20. Perform a "test payroll".
Perform "test payroll"
Payroll > Utilities > Pre-Edit Payroll Data

Run this utility to perform what could be called a “test payroll” for employees that meet the
selected parameters.

It is a partial run of calculations and it does not use transmittals or leave files. This utility can be
run in either the current year or next year.

An unprocessed pay date is required to be entered. If there are no unprocessed pay dates in the
Pay Dates table, enter a pay date for the next month. For example, August payroll has been
processed and pay dates for the new school year have not been entered yet.

Note: This utility should be run prior to creating your budget extract or before copying the
next year to the current year. This utility creates a report that displays errors on each
employee. The report is sorted by employee number order and provides error messages
that are easy to understand so that corrections can be made prior to extracting for budget.
Remember, if changes are made to the employee records, calculations need to be run
again.

21. Extract payroll account codes.
Extract payroll account codes

Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Payroll Account Codes

Before interfacing the payroll to the budget, verify the following:

o Are all new employees in the system?

o Are all employees active that are to be extracted to budget?

o Are all Staff/Job Pay data tabs updated and complete for new and existing employees?
o Does the next fiscal year in distributions match the budget fiscal year?

o Are all deductions updated?

o Are all extra duty stipends updated?
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o Since the next year payroll budget calculations use the s-type extra duty remaining
amounts, verify that these amounts have been updated.

Run this utility to extract payroll account codes for specific active (pay status 1) employees who
are in the next year payroll. The resulting extract is used to transfer this information to the
budget. This process can be repeated as often as necessary.

EXTRACT PATROLL ACCOUNT CODES.  EXTRACT REPORTS  INTERFACE T BUDGET

0oooo
]

........

Oo0o0o0oooooooo

J

O If applicable, select Exclude TRS On-Behalf Calculations.

O If you interface the on-behalf expenditures (6144) into Budget, manually input the revenue
for the on-behalf account codes (5831).

22. Verify the Extract Reports tab.
Verify Extract Reports tab
Payroll > Next Year > Interface NY Payroll to NY Budget > Extract Reports

Use the reports to verify the accuracy and validity of the employees, accounts, and amounts.

EXTRALT PAYROLL ACCOUNT ODDES EXTRACT REPORTS INTERFACE TO BUDGET

Peut Yaar Payrnlt Ectract Beports

Gen Apt Repet Sort Dptions Tt Orier
D Haxt Year Fayrall brgloyes [ pha Campus [C). Primar ™ l:l
o ' ]

Pay special attention to the employee count to verify that the correct number of employees are
extracted and match the count on the Next Year Payroll Employee Distribution Report.
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Date Fun: INext Yoar Payroll Emplayee Distribution Program:  HR:SODE0
Cnty Diist: (5] Page: 1of n
Fr EmpMNbr Empioyes Name TEA TRS On
Account Code Typ WIC 373 Gn Pa% Amaourt FICA Medicare  Insursnce Contlt Wi Comp  Behalf Unaemg TRS  TRS Care Dop Core
frenmnnn G147 =nnund) ) (--6142-<) (--5142-2) [--6143-<) (--614d-2) [=B6145) (ewnens Wy I A, ) (--B148.4)
Ann i HSA | Def Comp | Emplr Misc
[rommmmnenenns B148- e )
F 000400 ANDREWS. JULIE PayCmp001 FICA M TRSS: 1 Unemp: Y Day%: 10000 ExpDist Exp Tt Deg: O
199-41-6129.00-750-699000 G C N 100,000 2252976 o J24.07 576 00 00 183055 00 92335 00 o0
0o 0a 00
Cafe Ame:  180.24 2581549 Empiloyeo Totals: 2252078 00 2407 576 00 00 1EMSE 00 92935 o0 o0
00 00 o0
Prim Job Code PetAsgn  Prim Camp Typ Gty At Sid Pay Begin D State Min Dirys MoContr Py Grd WIC Cd Actcrus Cd
Extra Duty Cd SiMin Salary Dl Pay Rate Local Nbs Days Empld  AnnPymis  Step WIC Pymis  Accrue Rate
Wholly Sep
Y 0400 - SECRETARY 100.00 o 2 25278 187748 07-29-2024 1587 0 c A
00 136544 252978 185 12 0 136 544
0o
Ded EmpAsmt Pmi Cal Empr Fac TEAF Ded EmpAmt Pmi Caf Emge Fac TEAF Ded EmpAmt Pmit Cal Empr Fac TEAF
008 500 99N 00 1 1 200 me B8y 00 1 1 208 00 9 N 12 1 1
= o 99N B 1 629 5000 ¥ N 00 1 1
F 000446 APPLEGATE, CHRISTINA ELAINE PayCmpc001 FICA: M TRSSt 1 Unemp: Y Doy % 10000 ExpDist Exp Tot: Deg: 0
195-11612900:001-611000 G A N 00000 3747048 0 5430 576 00 12924 355870 {14] 1.030.44 00 oo
oy 00 00
Cole Ame: .00 427395 Empioyes Totals: A48 o0 Lok k] LN 00 12924 315500 00 1.030.44 0 0
00 00 00
Prm Job Code Pet Asgn  Prim Camp Typ Contr Ami Sud Pay Bagin Dt State Min Days Mo Contr Py Ged WIC Cd Accrue Cd
Extra Duty Ca St Min Salary Diy Pay Rate Lecal Mbxr Days Empld Ann Pymis Step WIC Pymis Accrue Rabe
Wholly Sep
Y (426- TEACHER'S AIDE 100.00 001 2 37470438 312254 O7-23-2024 0 w A A
00 227054 3747043 165 12 7 27094
00
Ded EmpAma Pmt Cof Emge  Fac TEAF Ded EmpAmt Pmt Cof Emgr Foc TEAF Ded EmpAmt Pmt Cal Empr Fac TEAF
003 500 ON 00 1 1 208 00 %N 131 1 604 o | N B 1
620 850 O N 001 1 622 1000 ON 00 1 1
Date Run: Mext Year Payroll Account Distribution Program: HRS9970
Cnity Dist: ISD Page: 10of 22
Sort Order: Fund
Account Code Amount
199-11-6119.00-001-611000 TEACHER SALARIES, GEN INSTRUCT
E 000443 22.112.86
E 000461 13.142.50
F 000450 3205415
£ 000459 20.050.00
E 000462 33.298.50
F 000372 26.771.50
E 000435 41.090.34
F 000452 2.000.01
E 000445 875.00
F 000460 750.00
E 000218 35.861.10
E 000382 29.936.65
Total: 257.942.61
199-11-6119.00-001-621000 TEACHER SALARY
F 000450 2.700.84
F 000348 850.00
Totalk 3,550.84
199-11-6119.00-001-622000 PROFESSIONAL SALARIES
E 000443 268415
F 000452 500.01
E 000445 61.498.34

23. (If necessary) Perform another extract and interface to Budget.

(If necessary) Perform another extract and interface to Budget

If changes are made to employee salary information, employees are added, employees are
inactivated, or termination dates are entered, perform another extract and interface those new
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changes to Budget.

Note: Updates to the budget will replace the existing amounts for those account
distribution codes that match the accounts in Budget. If an account distribution code no
longer exists in payroll when interfaced to Budget (after previous interfaces), the account
code is not changed or removed in Budget. You must manually modify the budget for those
account codes. This also applies to those amounts in the budget that have been manually
modified after the initial interface from payroll. If the budget account is not locked and the
change needs to be retained for budget purposes, all manual modifications need to be
made again.

24. Interface to Budget.
Interface to Budget

Payroll > Next Year > Interface NY Payroll to NY Budget > Interface to Budget

EXTRACT PAYROLL ACCOUNT CODES EXTRACT REPORTS INTERFACE TO BUDGET

Meact Year Payroll Round acocount totals to the nearest dollar
D Use Budget Crosswalk tables

@ Mext ¥r Recommend

(O Mext ¥r Approved

If all of the information is correct:
O Under Next Year Payroll, select one of the following columns to be updated in Budget:

o Next Yr Recommend
o Next Yr Approved

O Click Interface. This process can be repeated as often as necessary until the Board approves
the budget. For each run, the Next Year Budget amount is replaced. If the budget lock flag is
set on an account, the budget amount is not replaced.

If distributions or employees are changed after the first calculations are interfaced, you
may be required to log back on to the current pay frequency and use the Payroll > Next
Year > Copy CYR Tables to NYR > Clear Next Year Tables tab with the Clear NY Payroll
Budget Only option selected to recalculate and interface the new changes back to the
next year frequency.

Contact your regional ESC consultant if you need additional assistance.
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25. Perform staff benefits update.
Perform staff benefits update
Payroll > Utilities > Employee Benefits Interface > Import Annual File

Perform the employee benefits update and import process.

Year: i Frequency: |

EXTRALCT IMPOAT ANMUAL FILE MPORT CHAMNGES DMLY

[ Under Year Selection, select one of the following:

o Current Year

o Next Year
Active Employees |Select to base the selected pay frequency for the records on the
Only highest pay frequency in which the employee is active.
Deduction Import [Click Browse, and then select the folder to which a copy of the
Path deductions is to be imported. Click OK to select the folder or Cancel to
close the dialog box without processing.

O Click Execute to start the import process.

o In the application dialog box, verify the path of the import, and click Yes to continue the
import or No to return to the import dialog box.

o In the archive password dialog box, type a password for this imported file. Click OK.

o The files are imported, and a message is displayed indicating the import process
completed successfully. Click OK.

If any errors are encountered during the import process, an error report is displayed. If there
are no errors, the error report is not displayed.

If no errors are encountered during the import process, or you clicked Continue from the error
report, the import report is displayed.

Review the report.
O Click Continue to proceed.

O If you click Process, a message is displayed indicating that the data was imported. Click OK.
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